
ใบงานที่ 13 
การรับส่งข้อมูลระหว่างอุปกรณ์ 

จุดประสงค์การเรียนรู้ 
 1.ศึกษาการรับส่งข้อมูลระหว่างอุปกรณ์ผ่าน SPI บัส 
 2.ศึกษาการรับส่งข้อมูลระหว่างอุปกรณ์ผ่าน I2C บัส 
 3.ศึกษาการแสดงข้อความออกทางโมดูล LCD 
 4.ศึกษาการปรับแต่งและควบคุมการแสดงผลบนหน้าจอ LCD 
 5.ศึกษาการแสดงข้อความออกทางโมดูลจอ OLED 
 6.ศึกษาการแสดงภาพกราฟิกออกทางโมดูลจอ OLED 
เคร่ืองมือและอุปกรณ์การทดลอง 
 1.เครื่องไมโครคอมพิวเตอร์ 
 2.บอรด์ NodeMCU ESP32 
 3.โปรแกรมการทดลอง 
 4.อุปกรณ์อิเล็กทอรนิกส์ส าหรับทดลอง 
การทดลองที่ 1 การรับส่งข้อมูลระหว่างอุปกรณ์ผ่าน SPI บัส 
อุปกรณ์ในการทดลอง 
 1.บอรด์ NodeMCU ESP32 
 2.บอดร์ Arduino Uno R3 
 3.แผงต่อวงจร 
 4.สายไฟต่อวงจร 
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ประกอบวงจรตามรูป 
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 ตัวอย่างนี้จะเป็นการทดลองส่งข้อมูลไปมาระหว่าง NodeMCU ESP32 กับ Arduino Uno โดยใช้ SPI 
บัส ซึ่งในท่ีนี้เลือกใช้บอร์ด NodeMCU ESP32 เป็น Master ส่งข้อมูลเป็นตัวเลข “2” ไปยังบอร์ด Arduino 
Uno ท่ีเป็น Slave ทุกๆ 1 วินาที ระหว่างนั้นอุปกรณ์ Slave ก็จะน าเอาข้อมูลตัวเลขท่ีรับมาไปค านวณตาม
ค าส่ัง โดยในท่ีนี้ให้คูณด้วย “8” ก่อนจะส่งผลลัพธ์ที่ได้กลับไปยังอุปกรณ์ Master หรือในท่ีนี้ก็คือบอร์ด 
NodeMCU ESP32 โดยเราจะใช้หน้าต่าง Serial Monitor ของ Master ตรวจดูผลลัพธ์ทั้งก่อนท่ีข้อมูลจะถูก
ส่งไปยัง Slave และหลังจากท่ีข้อมูลถูกค านวณเสร็จแล้ว และถูกส่งกลับมายัง Master เพื่อพิสูจน์ว่า มีการ
รับส่งข้อมูลระหว่าง อุปกรณ์ Master และ Slave จริงๆ  
 ลงมือต่อวงจรตามรูป ส าหรับบอร์ด NodeMCU ท่ีเป็น Master ในท่ีนี้จะใช้ขา SCLK, MISO, MOSI 
และ CS/SS ตรงต าแหน่งขา GPIO18, GPIO19, GPIO23 และ GPIO2 ส่วนบอร์ด Arduino Uno ท่ีเป็น 
Slave จะ ใช้ขา SCLK, MISO, MOSI และ CS/SS ตรงต าแหน่งขา D13, D12, D11 และ D10 การเช่ือมต่อ
เพียงแค่ใช้สาย สัญญาณเสียบโยงขาต่างๆ เข้าหากัน ดังรูป ซึ่งรวมถงึขา GND ท่ีต้องต่อร่วมระหว่างกันเอาไว้
ด้วย 
 
โค้ดโปรแกรมสําหรับบอร์ด NodeMCU ที่เป็น Master 
 ท าหน้าท่ีส่งข้อมูลตัวเลข “2” ผ่าน SPI บัสไปยังบอร์ด Slave และรับข้อมูลท่ีผ่านการค านวณตาม
ค าส่ัง จาก Slave กลับมายัง Master เพื่อแสดงค่าออกทาง Serial Monitor 
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โค้ดโปรแกรมสําหรับบอร์ด Arduino Uno ที่เปน็ Slave 
 ท าหน้าท่ีรับข้อมูลตัวเลขจากบอร์ด Master มาค านวณตามค าส่ัง ด้วยการคูณด้วย “3” แล้วส่ง
ผลลัพธ์ผ่าน SPI บัส กลับไปยังบอร์ด Master 
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 จากนั้นให้เราทดสอบดูว่ามีการ ส่งข้อมูลจาก Master ผ่าน SPI บัสไปยัง Slave หรือไม่ ด้วยการดึง
สาย MISO ท่ีเช่ือมต่อระหว่างขา GPIO19 ของ Master กับขา D12 ของ Slave ด้านใดด้านหนึ่งออก เพื่อ
ยกเลิกการ ส่งข้อมูลหรือผลลัพธ์ที่ได้จากการค านวณจาก Slave กลับมายัง Master จากนั้นไปท่ีหน้าต่าง 
Arduino IDE ท่ี เราอัพโหลดโค้ดโปรแกรมให้กับบอร์ด Master หรือในท่ีนี้คือ NodeMCU ให้ เราเปิดหน้าต่าง 
Serial Monitor ขึ้นมา จะเห็นข้อความและผลลัพธ์ของตัวเลข เป็น “0” ดังรูป 
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 ต่อมาให้เราทดสอบดูว่าข้อมูลท่ี ถูกส่งจาก Master ไปยัง Slave ถูก น าไปค านวณตามค าส่ังแล้วส่งผล
ลัพธ์ ของการค านวณผ่าน SPI บัสกลับ มายัง Master หรือไม่ ด้วยการเสียบสาย MISO เมื่อสักครู่กลับเข้าท่ี
เดิม ผลลัพธ์ที่ได้คือ ในหน้าต่าง Serial Monitor จะเห็นข้อความและผลลัพธ์ ของตัวเลขเป็น “16” ซึ่งก็คือ
ค่าท่ีได้ จากการค านวณท่ี Slave ส่งกลับมา ยัง Master นั่นเอง ดังรูป 

 
บันทึกผลการทดลอง 
…………………………………………………………………………………………………………………………………………………………… 
…………………………………………………………………………………………………………………………………………………………… 
…………………………………………………………………………………………………………………………………………………………… 
…………………………………………………………………………………………………………………………………………………………… 
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การทดลองที่ 2 การรับส่งข้อมูลระหว่างอุปกรณ์ผ่าน I2C บัส 
อุปกรณ์ในการทดลอง 
 1.บอรด์ NodeMCU ESP32 
 2.บอดร์ Arduino Uno R3 
 3.หลอดไฟ LED 
 4.ตัวต้านทาน (Resistor) 
 5.แผงต่อวงจร 
 6.สายไฟต่อวงจร 
ประกอบวงจรตามรูป 
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 ลงมือต่อวงจรตามรูป ส าหรับบอร์ด NodeMCU ท่ีเป็น Master ในท่ีนี้จะใช้ขา SCL และ SDA ตรง
ต าแหน่ง ขา GPIO22 และ GPIO21 ส่วนบอร์ด Arduino Uno ท่ีเป็น Slave จะใช้ขา SCL และ SDA ตรง
ต าแหน่งขา A5 และ A4 การเช่ือมต่อเพียงแค่ใช้สายสัญญาณเสียบโยงระหว่างขา GPIO22 กับ A5 ส าหรับ 
SCL และขา GPIO21 กับ A4 ส าหรับ SDA ดังรูป รวมถึงขา GND ท่ีต้องต่อร่วมระหว่างกันเอาไว้ด้วย ส่วน
หลอดไฟ LED ท่ีใช้แสดงสถานะเปิด/ปิด ให้เอาข้ัวบวกหรือ Anode (+) ซึ่งมีขาท่ียาวกว่า ต่อกับขา 13 ของ
บอร์ด Arduino Uno ท่ีเป็น Slave (ในท่ีนี้ก าหนดให้เป็น Output) โดยให้มีตัวต้านทาน 2200 ค่ันเอาไว้ 
ส าหรับข้ัวลบหรือ Cathode (-) ก็ให้ต่อกับกราวด์ (GND) 
 หลังจากลงมือเช่ือมต่อสายสัญญาณต่างๆ เรียบร้อยแล้ว ข้ันตอนต่อไปก็คือ การเขียนโค้ดและอัพโหลด 
โปรแกรม โดยเราจะต้องเขียนโค้ดขึ้นมา 2 ชุด ชุดแรกส าหรับอัพโหลดไปยังบอร์ด NodeMCU ท่ีเป็น Master 
และชุดสองส าหรับบอร์ด Arduino Uno ท่ีเป็น Slave ซึ่งมีรายละเอียดดังนี ้
 
โค้ดโปรแกรมสําหรับบอร์ด NodeMCU ที่เป็น Master 
 เป็นโค้ดท่ีใช้ตรวจสอบตัวอักษรท่ีกรอกลงไปใน Serial Monitor แล้วส่งข้อมูลตัวอักษรดังกล่าวไปยัง
บอร์ด Arduino Uno ท่ีเป็น Slave ผ่านทาง I2C บัส 
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โค้ดโปรแกรมสําหรับบอร์ด Arduino Uno ที่เปน็ Slave 
 เป็นโค้ดท่ีใช้แสดงสถานะของข้อมูลท่ีรับมาจากบอร์ด NodeMCU ท่ีเป็น Master ซึ่งถ้าข้อมูลท่ีรับมา
เป็น “1” หรือมีการพิมพ์ค าว่า “ON” จะท าให้สถานะของหลอดไฟ LED ท่ีเช่ือมต่ออยู่กับขา 13 ติด แต่ถ้า
ข้อมูล ท่ีรับมาเป็น “0” หรือพิมพ์ค าว่า “OFF” จะท าให้สถานะของหลอดไฟ ดับ 
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 หลังจากอัพโหลดโค้ดโปรแกรมให้กับบอร์ดท้ัง 2 แล้ว จากนั้นเสียบสาย USB ให้กับบอร์ดท้ัง 2 เพื่อ
จ่ายไฟเล้ียง 
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 จากนั้นให้เราเปิดหน้าต่าง Serial Monitor ของบอร์ด NodeMCU ท่ีเป็น Master แล้วทดสอบด้วย
การพิมพ์ค าว่า “ON” แล้วกดคีย์ Enter หรือกดปุ่ม Send 
 ถ้าทุกอย่างถูกต้อง หลอดไฟ LED ท่ีเช่ือมต่ออยู่กับบอร์ด Arduino Uno ท่ีเป็น Slave จะติด (ดังรูป) 

 
 พิมพ์ค าว่า “OFF” แล้วกดคีย์ Enter หรือกดปุ่ม Send ถ้าทุกอย่างถูกต้อง หลอดไฟ LED ท่ีเช่ือมต่อ
อยู่ กับบอร์ด Arduino Uno ที เป็น Slave จะดับ (ดังรูป) 

 
บันทึกผลการทดลอง 
…………………………………………………………………………………………………………………………………………………………… 
…………………………………………………………………………………………………………………………………………………………… 
…………………………………………………………………………………………………………………………………………………………… 
…………………………………………………………………………………………………………………………………………………………… 
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การทดลองที่ 3 การแสดงข้อความออกทางโมดูล LCD 
อุปกรณ์ในการทดลอง 
 1.บอรด์ NodeMCU ESP32 
 2.โมดูลจอ LCD ขนาด 16x2 
 3.แผงต่อวงจร 
 4.สายไฟต่อวงจร 
ประกอบวงจรตามรูป 

 
 
 ลงมือต่อวงจรตามรูป ซึ่งเป็นผังการต่อวงจรจากตัวอย่างท่ีแล้ว หลังจากเช่ือมต่อสายสัญญาณต่างๆ 
เสร็จ ขั้นตอนต่อไปก็คือ การเขียนโค้ดและอัพโหลดโปรแกรม แต่ในท่ีนี้เนื่องจากโมดูลจอ LCD จะเป็นอุปกรณ์
ท่ีมี คอนโทรลเลอร์ส าหรับควบคุมการแสดงผลมาให้อยู่แล้ว ดังนั้นการจะติดต่อกับโมดูลจอ LCD ได้นั้น จ าเป็น
จะ ต้องส่ังงานผ่านไลบรารี่ (Library) ท่ีช่ือว่า LiquidCrystal_I2C และในกรณีนี้เนื่องจากบอร์ด MCU ท่ีเราใช้ 
เป็น NodeMCU ESP32 ดังนั้นไลบรารี่ LiquidCrystal_I2C ท่ีใช้ จะต้องสนับสนุนบอร์ด MCU นี้ด้วย เพราะ 
ฉะนั้นก่อนท่ีเราจะลงมือเขียนโค้ด เราจึงต้องมีการติดต้ังไลบรารี่ (Library) ดังกล่าวนี้ให้กับโปรแกรม Arduino 
IDE เสียก่อน ซึ่งการดาวน์โหลดและติดต้ังมีข้ันตอนง่ายๆ ดังนี้ 
 1. ไปท่ีเว็บไซต์ https://github.com/nhatuan84/esp32-lcd หรือค้นหาแหล่งดาวน์โหลดจาก 
Google โดยใช้ค าค้นหาว่า LiquidCrystal_I2C ESP32 ก็ได้ จากนั้นไฟล์ท่ีดาวน์โหลดมาจะเป็นไฟล์ zip เช่น 
esp32-lcd-master.zip เป็นต้น 
 2. ติดต้ังไลบรารี่ (Library) ให้กับ Arduino IDE โดยใช้ตัว Manager ของ Arduino IDE ด้วยการคลิก
ท่ีเมนู Sketch - Include Library - Add .ZIP Library.... หรือจะใช้วิธีแบบ Manual โดยแตกซิป แล้วเปล่ียน 
ช่ือโฟลเดอร์เป็น LiquidCrystal_I2C จากนั้นค่อยก็อปป้ีโฟลเดอร์นี้ไปวางไว้ที่ Documents\Arduino 
Libraries ก็ได้ แต่วิธีนี้หลังจากท าเสร็จอาจจะต้องปิดและเปิด Arduino IDE ใหม่ เพื่อให้โปรแกรมมอง เห็น
ไลบรารี่ท่ีเพิ่มเข้าไป 
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 3. สุดท้ายหลังจากติดต้ังไลบรารี่ (Library) เสร็จ ก็ให้เข้าไปตรวจสอบท่ี Arduino IDE ดูว่ามีช่ือไลบรา
รี่ท่ีเรา เพิ่งจะติดต้ังถูกเพิ่มเข้าไปรายช่ือไลบรารี่ท้ังหมดแล้วหรือยัง โดยคลิกไปท่ีเมนู Sketch » Include 
Library หรือจะคลิกดูท่ีเมนู File > Examples ก็ได้ ซึ่งในกรณีนี้จะต้องปรากฏช่ือไลบรารี่ว่า esp32-lcd-
master ถ้าพบแล้วแสดงว่าการติดต้ังเสร็จเรียบร้อย พร้อมใช้งานแล้ว 
หลังจากติดต้ังไลบรารี่ (Library) เพื่อให้บอร์ด NodeMCU ESP32 สามารถติดต่อกับโมดูลจอ LCD ได้ เสร็จ
เรียบร้อยแล้ว ก็ถึงเวลาท่ีเราจะต้องมาลงมือเขียนโค้ดและอัพโหลดโปรแกรมซักที 
 ในตัวอย่างนี้เริ่มต้นให้เราทดลองส่งข้อความ Hello, world! และ I Love IoT ไปแสดงบนหน้าจอ 
LCD โดยในท่ีนี้ จะใช้โค้ดโปรแกรมจากไฟล์ตัวอย่างท่ีให้มา เริ่มต้นท่ี Arduino IDE คลิกเมนู File » Examples 
» esp32-lcd-master » esp32lcd จะปรากฏหน้าต่างแสดงโค้ดโปรแกรม ดังนี้ 

 
 จากนั้นให้อัพโหลดโค้ดโปรแกรมลงไปบนบอร์ด จะเห็นข้อความปรากฏบนหน้าจอ LCD ดังรูป 
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บันทึกผลการทดลอง 
…………………………………………………………………………………………………………………………………………………………… 
…………………………………………………………………………………………………………………………………………………………… 
…………………………………………………………………………………………………………………………………………………………… 
…………………………………………………………………………………………………………………………………………………………… 
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การทดลองที่ 4 การปรับแต่งและควบคุมการแสดงผลบนหน้าจอ LCD 
 จากตัวอย่างท่ีผ่านมา เราได้ทดลองเช่ือมต่อโมดูลจอ 16x2 Character LCD ท่ีมาพร้อม I2C LCD 
Controller เข้ากับบอร์ด NodeMCU ESP32 ซึ่งได้ท าการตรวจสอบหมายเลขแอดเดรสของโมดูลจอ LCD ท่ี
ใช้ติดต่อผ่าน I2C บัส และได้ทดลองกันตัวอย่างโค้ดจากไลบรารี่ LiquidCrystal_I2C ท่ีใช้แสดงข้อความ 
Hello, world! ออกทางหน้าจอของโมดูล LCD กันไปแล้ว มาถึงตัวอย่างนี้เราจะมาทดลองท าอะไรท่ีเกี่ยวข้อง 
กับการแสดงผลบนหน้าจอ LCD ท่ีซับซ้อนขึ้นไปอีก เช่น การแสดงข้อความ 2 บรรทัด, การแสดงตัวอักขระ
พิเศษ รูปหัวใจ, การเล่ือนข้อความไปทางซ้าย/ขวา, การควบคุมการปิด/เปิดแสดงข้อความและไฟ Backlight 
และการ ควบคุมต าแหน่งของเคอร์เซอร์ ซึ่งมีข้ันตอนต่างๆ ดังนี้ 
 จากตัวอย่างท่ีแล้วการเช่ือมต่ออุปกรณ์ยังคงเหมือนเดิม เพียงแต่ให้เราเอาโค้ดโปรแกรมมาแก้ไข ซึ่งมี 
รายละเอียดดังนี้ 
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 การท างานของโปรแกรม เริ่มต้นไฟ Backlight ของจอ LCD จะถูกเปิด พร้อมแสดงข้อความ Node 
MCU ESP32 ไว้ที่จุดเริ่มต้นหรือก็คือ คอลัมน์ซ้ายสุดของบรรทัดแรก รอเวลา 2 วินาที จากนั้นเคอร์เซอร์ถูก
ก าหนด ให้ไปรอท่ีต าแหน่งคอลัมน์ซ้ายสุดของบรรทัดถัดมา พร้อมแสดงข้อความ Passakorn รอเวลา 2 วินาที 
ต่อมา เคอร์เซอร์ถูกก าหนดให้ไปรอท่ีต าแหน่งคอลัมน์ 10 (นับจากคอลัมน์ซ้ายสุดคือ 0 มาทางขวาทีละ 1 
จนถึงคอลัมน์ ท่ี 10) ของบรรทัดเดิม พร้อมแสดงข้อความ IoT จากนั้นเคอร์เซอร์ถูกก าหนดให้ไปรอท่ีต าแหน่ง
คอลัมน์ 14 ของบรรทัดเดียวกัน พร้อมแสดงตัวอักขระรูปหัวใจจากค่าท่ีเราก าหนด ก่อนจะเล่ือนการแสดงผล
บนหน้าจอ ไปทางซ้ายจ านวน 15 คอลัมน์ ใช้เวลาคอลัมน์ละ 0.2 วินาที จากนั้นเล่ือนกลับมาทางขวาจ านวน 
32 คอลัมน์ และสุดท้ายเล่ือนกลับไปทางซ้ายจ านวน 16 คอลัมน์ ซึ่งก็คือจุดเริ่มต้นในตอนแรก จากนั้นรอเวลา 
2 วินาที แล้ว ตามด้วยการกะพริบข้อความท้ังหมดบนหน้าจอ 3 ครั้ง ก่อนจะลบข้อความและปิดการแสดงผล
ท้ังหมด สุดท้าย ปิดไฟ Backlight บนหน้าจอ และหลังจากนั้น 2 วินาที ก็จะเริ่มต้นการท างานท้ังหมดใหม่อีก
ครั้ง วนไปเรื่อยๆ  
 หลังจากอัพโหลดโค้ดโปรแกรมลงไปบนบอร์ดเรียบร้อยแล้ว ผลลัพธ์ที่ได้จากการแสดงผลบนหน้าจอ 
LCD จะเป็นดังรูป 

 
 
บันทึกผลการทดลอง 
…………………………………………………………………………………………………………………………………………………………… 
…………………………………………………………………………………………………………………………………………………………… 
…………………………………………………………………………………………………………………………………………………………… 
…………………………………………………………………………………………………………………………………………………………… 
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การทดลองที่ 5 การแสดงข้อความออกทางโมดูลจอ OLED 
อุปกรณ์ในการทดลอง 
 1.บอรด์ NodeMCU ESP32 
 2.โมดูลจอ OLED 
 3.แผงต่อวงจร 
 4.สายไฟต่อวงจร 
ประกอบวงจรตามรูป 
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 หลังจากลงมือเช่ือมต่อสายสัญญาณต่างๆ เรียบร้อยแล้ว ข้ันตอนต่อไปก็คือ การเขียนโค้ดและอัพโหลด 
โปรแกรม แต่ในท่ีนี้เนื่องจากโมดูลจอ OLED จะมีชิป IC Controller ท่ีใช้ควบคุมการแสดงผลมาให้ในตัว 
เพราะฉะนั้นก่อนจะลงมือเขียนโค้ด เราจะต้องติดต้ังไลบรารี่ (Library) ท่ีจ าเป็นให้กับ Arduino IDE เสียก่อน 
ซึ่งมีข้ันตอนส้ันๆ คือ 
1. Arduino IDE คลิกเมนู Tools » Manage Libraries... หรือกดคีย์ Ctrl + Shift + I 
2. ในช่อง Search พิมพ์ค าว่า ssd1306 แล้วกดคีย์ Enter 
3. ท่ีไลบรารี่ Adafruit SSD1306 คลิกปุ่ม Install เพื่อติดต้ัง 

 
4. จะปรากฏหน้าต่างแจ้งว่าไลบรารี่นี้จ าเป็น ต้องใช้งานไลบรารี่อื่นๆ เช่น Adafruit GFX Library และ 
Adafruit BusIO ร่วมด้วยซึ่งยังไม่ได้ถูกติดต้ัง ในท่ีนี้ให้เราเลือกว่า จะติดต้ังท้ังหมด คลิกปุ่ม Install all 
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 หลังจากอัพโหลดโค้ดโปรแกรมลงไปบนบอร์ดเรียบร้อยแล้ว ผลลัพธ์ที่ได้จะเป็นดังรูป 

 
 ต่อมาเราจะลองเพิ่มโค้ดเพื่อกลับสีตัวอักษรและพื้นหลังให้เป็นสีตรงกันข้ามดูบ้าง โดยจะให้แสดง
ผลลัพธ์ หลังจากแสดงข้อความก่อนหน้านี้ผ่านไปแล้ว 2 วินาที ให้เราน าโค้ดเดิมมาแก้ไข โดยใส่รายละเอียดดัง
ในกรอบเพิ่มเติมเข้าไป 
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 หลังจากอัพโหลดโค้ดโปรแกรมลงไปบนบอร์ดเรียบร้อยแล้ว ผลลัพธ์ที่ได้จะเป็นดังรูป 

 
 
 ต่อมาเราจะลองเพิ่มโค้ดเพื่อปรับขนาดตัวอักษรให้ใหญ่ขึ้น โดยจะให้แสดงผลลัพธ์หลังจากกลับสี
ตัวอักษร และพื้นหลังผ่านไปแล้ว 2 วินาที ให้เราน าโค้ดเดิมมาแก้ไข โดยใส่รายละเอียดดังในกรอบเพิ่มเติมเข้า
ไป 
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 หลังจากอัพโหลดโค้ด โปรแกรมลงไปบนบอร์ด เรียบร้อยแล้ว ผลลัพธ์ที่ได้ จะเป็นดังรูป 
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 ต่อมาเราจะลองเพิ่มโค้ดเพื่อแปลงค่าตัวเลข 0xE6 จากตัวเลขฐาน 16 ไปเป็นฐาน 10 พร้อมท้ังปรับ
ขนาด ตัวอักษรให้เล็กลง โดยจะให้แสดงผลลัพธ์หลังจากท่ีก่อนหน้านี้ ได้ปรับขนาดตัวอักษรให้ใหญ่ขึ้นผ่านไป
แล้ว 2 วินาที ให้เราน าโค้ดเดิมมาแก้ไข โดยใส่รายละเอียดดังในกรอบเพิ่มเติมเข้าไป 

 
 หลังจากอัพโหลดโค้ดโปรแกรมลงไปบนบอร์ดเรียบร้อยแล้ว ผลลัพธ์ที่ได้จะเป็นดังรูป 
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 ต่อมาเราจะลองเพิ่มโค้ดเพื่อเล่ือนต าแหน่งข้อความท้ัง 3 บรรทัดบนหน้าจอไปทางขวา, ซ้าย, ทแยง
ขวา และซ้าย โดยจะให้แสดงผลลัพธ์หลังจากท่ีได้แสดงการแปลงค่าตัวเลขผ่านไปแล้ว 2 วินาที ให้เราน าโค้ด
เดิมมา แก้ไข โดยใส่รายละเอียดดังในกรอบเพิ่มเติมเข้าไป 
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 หลังจากอัพโหลดโค้ดโปรแกรมลงไปบนบอร์ดเรียบร้อยแล้ว ผลลัพธ์ที่ได้ จะเป็นดังรูป 
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 ต่อมาเราจะลองเพิ่มโค้ดเพื่อเล่ือนเฉพาะข้อความในบรรทัดแรกไปทางขวา ให้เราน าโค้ดเดิมมาแก้ไข 
โดยใส่รายละเอียดดังในกรอบเพิ่มเติมเข้าไป 

 

 
 หลังจากอัพโหลดโค้ดโปรแกรมลงไปบนบอร์ดเรียบร้อยแล้ว ผลลัพธ์ที่ได้จะเป็นดังรูป 
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 สุดท้ายเราจะลองเพิ่มโค้ดเพื่อวาดรูปพื้นท่ีวงกลมวางไว้กลางหน้าจอพร้อมแสดงข้อความก ากับไว้ที่ 
ด้านบน ให้เราน าโค้ดเดิมมาแก้ไข โดยใส่รายละเอียดดังในกรอบเพิ่มเติมเข้าไป 

 
 



รหัสวิชา 20127-2007 127 วิชา ดิจิทัลและไมโครคอนโทรลเลอร์ 

วิทยาลัยเทคนิคชลบุรี  จัดท าโดย นายวิรุณ  จิตต์บุญ 

 
 หลังจากอัพโหลดโค้ดโปรแกรมลงไปบนบอร์ดเรียบร้อยแล้ว ผลลัพธ์ที่ได้จะเป็นดังรูป 

 
 
บันทึกผลการทดลอง 
…………………………………………………………………………………………………………………………………………………………… 
…………………………………………………………………………………………………………………………………………………………… 
…………………………………………………………………………………………………………………………………………………………… 
…………………………………………………………………………………………………………………………………………………………… 
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การทดลองที่ 6 การแสดงภาพกราฟิกออกทางโมดูลจอ OLED 

 
 
 ก่อนอื่นเราจะต้องมีการเตรียม ภาพเสียก่อน โดยภาพนี้จะถูกน าไป 
แปลงให้เป็นโค้ดตัวแปรอาร์เรย์ เพื่อ ท่ีจะน าไปใช้ในโค้ดโปรแกรม ส าหรับ ภาพท่ีน ามาใช้จะเป็นภาพอะไรก็ได้ 
แต่จะต้องมีการปรับให้มีขนาดเท่ากับ หน้าจอคือ 128x64 pixels และมีการ ปรับสีให้เป็นขาว-ด า (Black & 
White) ก่อน จากนั้นจึงค่อย Save ภาพให้เป็น ไฟล์ Bitmap (.bmp) แล้วน าไปแปลง ให้เป็นโค้ด ส าหรับ
น าไปใช้เป็นตัวแปร อาร์เรย์ ซึ่งการแปลงจะมีให้เลือกใช้อยู่ 2 วิธี 
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 วิธีแรกจะเป็นการใช้โปรแกรม LCD Assistant ท่ีสามารถดาวน์โหลดจากเว็บไซต์ http://en.radzio. 
dxp.p//bitmap_converter มาใช้งานได้ฟรี และวิธีท่ีสองจะเป็นการใช้เว็บแอพพลิเคช่ันท่ีช่ือว่า image2cpp 
ซึ่งสามารถเรียกใช้งานในแบบ Offline ได้ เพียงแค่ Save หน้าเพจเก็บไว้ในคอมพิวเตอร์ แล้วเปิดไฟล์ผ่าน 
Browser เพื่อเรียกใช้งาน แต่ในท่ีนี้เพื่อความสะ ท่ีนี้เพื่อความสะดวกจะเลือกใช้วิธีท่ีสองในแบบ Online โดย
เราได้เตรียมภาพท่ี เป็นไฟล์ .bmp ขนาด 128x64 pixels ท่ีมีการปรับสีเป็นขาว-ด าเตรียมไว้แล้ว (ในการ
เตรียมภาพจะใช้โปรแกรม อะไรก็ได้ เช่น Photoshop, Paint ฯลฯ แล้วแต่ถนัด) ส าหรับข้ันตอนในการแปลง
ภาพเป็นโค้ดตัวแปรอาร์เรย์ ด้วย image2cpp มีดังนี ้

 
1. ไปท่ีเว็บไซต์ http://javt.github.io/image2cpp/ คลิกปุ่ม Choose Files เพื่อเลือกภาพท่ีเตรียมไว้ 
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2. ก าหนดรายละเอียดให้กับภาพท่ี Brightness/alpha threshold ให้เราเพิ่มหรือปรับลดตัวเลข เพื่อก าหนด 
ความสว่างท่ีเหมาะสมให้กับภาพ โดยจะเห็นความเปล่ียนแปลงของภาพในแบบเรียลไทม์ได้จาก Preview ใน
ขั้นตอนท่ี 3 

 
 3. ขั้นตอนสุดท้าย ท่ี Code output format เลือกรูปแบบโค้ด ในท่ีนี้เลือก Arduino code และต้ัง
ช่ือท่ี จะใช้ระบุเป็นตัวช้ีมายังภาพในช่อง Identifier จากนั้นคลิกปุ่ม Generate code เราจะได้โค้ดตัวแปร 
อาร์เรย์ท่ีจะน าไปใส่ในโค้ดโปรแกรม ดังรูป 
  ส าหรับอุปกรณ์ท่ีใช้และการต่อวงจรก็คงไม่ต้องปรบัเปล่ียนอะไร เพราะเหมือนกับตัวอย่างท่ีแล้วมาทุก 
ประการ ทีนี้ก็ถึงเวลาท่ีเราจะต้องมาลงมือเขียนโค้ดและอัพโหลดโปรแกรมกันแล้ว ส าหรับรายละเอียดของโค้ด 
โปรแกรมมีดังนี ้
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 หลังจากอัพโหลดโค้ดโปรแกรมลงไปบนบอร์ดเรียบร้อยแล้ว ผลลัพธ์ที่ได้จะเป็นดังรูป 
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บันทึกผลการทดลอง 
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